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Вопросы по работе с изображением 

 

Как открыть сразу несколько изображений? 

Существует несколько способов открытия группы изображений. Можно с помощью диалога открытия файлов 
выделить несколько изображений и нажать кнопку Open. А можно выделить в списке панели Manager 
интересуемые изображения левой кнопкой мыши удерживая клавишу Ctrl, вызвать правой кнопкой мыши 
контекстное меню и выбрать команду Open. 

Изображение какого максимального объема может быть открыто приложением ScanMagic? 

Приложение ScanMagic благодаря технологии виртуальной подкачки данных позволяет открывать и работать 
с изображениями сколь угодно большого объема. Однако, для ряда форматов существуют ограничения  
поддерживаемого максимального объема изображений. 

Как сконвертировать изображение из одного формата в другой? 

Существует несколько способов для изменения формата изображения. Можно воспользоваться Растровым 
конвертером или просто открыть изображение и затем сохранить его в интересуемый формат. 

Как создать квиклук изображения? 

Нужно открыть изображение, выполнить его масшабирование и контрастирование в окне просмотра и 
сохранить его с помощью функции Save View As в интересуемый формат, например, в jpg. 

Чем отличаются опции Save Image As  и Save View As? 

В режиме Save Image As изображение экспортируется "как есть", то есть с исходным набором и порядком 
каналов, исходным радиометрическим разрешением и контрастированием. В режиме Save View As 
изображение экспортируется с параметрами отображения текущего окна просмотра изображения, то есть с 
текущим цветосинтезом (RGB) или выбором канала (Grayscale), текущим масштабом и  контрастированием, 
радиометрическим разрешением 8 бит/пиксель.  

Как сделать индексированное изображение с помощью своей палитры? 

Вам нужно открыть интересуемое изображение, перейти в закладку View,  установить переключатель Index 
Color и установить номер спектрального канала для визуализации. Для назначения  выбранному каналу 
палитры, нужно в появившемся диалоге Color Table создать палитру, выбрать из имеющихся или загрузить 
готовую нажатием кнопки Load. Для этого в появившемся окне выбора палитры необходимо указать имя 
палитры с расширением .pal и нажать на кнопну ОК. 

Как можно раскрасить DEM изображение рельефа? 

Вам нужно открыть DEM изображение, в закладке View установить переключатель Index Color и выбрать 
номер спектрального канала для отображений. Для назначения  палитры, нужно нажать кнопку выбора 
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палитры, и в появившемся диалоге Color Table задать интересуемую палитру из представленного списка или 
подгрузить свою палитру. После этого следует нажать кнопку ОК. 

Как визуализировать результат сегментации изображения? 

Результат сегментации записывается в первый по порядку канал «Band1» изображения. Для того чтобы 
визуализировать получившийся результат сегментации нужно воспользоваться режимом индексированных 
цветов, включив  переключатель Index Color  с выбранным по умолчанию  каналом «Band1». В диалоге Color 
Table в раскрывающемся списке палитр нужно выбрать палитру Segmentation или другую подходящую. 

Можно ли выполнить контрастирование изображения, используемого в создании Региона? 

Можно, для этого в элементе управления SubImage необходимо выбрать имя контрастируемого изображения 
и, используя элементы визуализации и представления изображений панели View, настроить параметры 
контрастирования изображения. Обратите внимание, что при выборе строки Region в элементе управления 
SubImage работа через панель инструментов осуществляется со всем изображением Региона, а при выборе 
имени одного из снимков, участвующих в монтаже, действия выполняются только с его изображением. 

Как получить RGB изображение из одноканальных файлов изображения (например, Landsat)? 

Нужно открыть в программе все однокональные файлы, создать мозаику из этих одноканальных снимков, 
присвоив каждому каналу мозаики канал одного из исходных изображений.  

Каким образом можно улучшить пространственное разрешение цветного снимка? 

Вам нужно открыть цветное изображение и соответствующее ему панхроматическое изображение с более 
высоким пространственным разрешением. Далее нужно создать Region, указав тип мозаики Synthesis From 
Multiple-Band Image и установив 4 выходных канала (три для цветного снимка и один для панхроматического). 
Далее следует запомнить, какому каналу Региона присвоен канал панхроматического изображения, и нажать 
кнопку Apply. После создания Региона в панели View нужно установить флажок Resolution Merge и задать 
номер канала панхроматического снимка.  

Не происходит трансформация в UTM зону. С чем это может быть связано? 

Проекция UTM является зональной проекцией, поэтому следует убедиться в правильности выбора зоны 
проекции или выбрать при трансформировании снимка опцию Autoselect, которая самостоятельно определит 
UTM зону, в которой находится изображение. 

Что представляет собой Диаграмма (Скатерограмма) остчетов яркости? 

Диаграмма отсчетов яркости представляет собой график, по оси абсцисс которого откладываются значения 
отсчетов яркости пикселей первого выбранного для анализа канала изображения, а по оси ординат -  
второго. Фактически это диаграмма рассеяния отсчетов яркости двух анализируемых каналов. 
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Вопросы по работе с  векторными картами 

 

Как создать новую векторную карту? 

Нужно открыть изображение и перейти на панель Vector. В группе элементов Vector Editor следует нажать 
кнопку «Start vector layer editing», после чего откроется диалог выбора типа векторного слоя. После выбора 
типа векторной карты, нужно нажать кнопку «Create object», после чего создать векторные объекты на 
изображении, устанавливая точки в интересуемых частях снимка. Завершить создание векторных объектов 
можно щелчком  правой кнопки мыши в конечной точке. После нанесения всех векторных объектов на 
изображение следует нажать кнопку «Stop vector layer editing», после чего в открывшемся диалоге сохранения 
файла присвоить векторной карте имя  и нажать кнопку «Save». 

Каким образом можно выполнить редактирование векторной карты? 

Вам нужно открыть изображение, нанести на него интересуемую векторную карту и выделить эту векторную 
карту в списке на панели Vector. Далее в группе элементов Vector Editor следует нажать кнопку «Start vector 
layer editing», после чего можно начинать редактированить векторные объекты карты. По окончании 
редактирования векторной карты следует нажать кнопку «Stop vector layer editing», после чего в открывшемся 
диалоге сохранения файла выбрать кнопку «Save» и выполнить сохранение векторной карты. 

Почему при редактировании векторных карт координаты векторных объектов загрубляются? 

Если на снимок низкого разрешения наносятся карты более высокого разрешения, то координаты векторных 
объектов этой карты загрубляются до пространственного разрешения снимка. Поэтому, если необходимо 
отредактировать какую-то векторную карту целиком с сохранением исходной детальности и точности всех 
объектов, то необходимо создать Region на всю данную территорию с высоким разрешением (не хуже чем 
точность координат карты), далее нанести на этот Region векторную карту, отредактировать ее и сохранить 
под другим именем. 

Каким образом можно вырезать фрагмент векторной карты? 

Можно воспользоваться векторным конвертером, диалог которого вызывается через меню Tools -> Vector 
Converter. В диалоговом окне следует добавить интересуемую векторную карту в список исходных файлов, 
установить флажок Cut Segment и задать границы (X, Y) вырезаемого фрагмента. Далее нужно нажать кнопку 
Convert. 

 

Вопросы по работе со средствами каталогизации 

 

Для каких задач могут потребоваться средства каталогизации? 

Если в область ваших задач входит работа с большим числом изображений, средства каталогизации, 
реализованные в приложении, позволят вам легко создавать каталоги изображений и быстро осуществлять 
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поиск снимков по атрибутам. Кроме того, приложение позволяет работать с каталогами, расположенными на 
других серверах, а также осуществлять экспорт и импорт метаданных. 

Как занести запись об изображении в каталог? 

Существует два способа занесения записей в каталог. Вы можете открыть изображение и выбрать пункт меню 
File-> Add to Catalog, в результате чего откроется форма добавления записей в каталог. После внесения 
информации о снимке  нужно нажать кнопку Save Record. Для занесения в каталог информации о снимках, 
представленных в виде списка в панели Manager, нужно выделить интересуемые снимки, нажать правую 
кнопку мыши и в контекстном меню выбрать пункт  Add to Catalog, после чего откроется форма добавления 
записей в каталог. Так же существует способ быстрого добавления изображений в текущую базу данных. Для 
его реализации необходимо в контекстном меню выбрать пункт Fast Add to Catalog. 

Как создать новую базу данных для каталога? 

После открытия формы добавления записей в каталог, Вы можете ввести имя новой базы данных в поле 
Database и нажать кнопку Save Record. После чего приложение выдаст диалог о подтвержении создания 
новой базы данных. Нажав ОК, вы сохраните интересуемую запись в новую базу данных. 

Как произвести выборку записей об изображениях, не содержащих географическую привязку? 

Вам нужно перейти на панель Catalog, в поле Database указать базу данных, из которой будет осуществляться 
выборка и в выпадающем списке Geolocated выбрать пункт NO. Затем нажмите кнопку Search. 

При работе с каталогом существует возможность сохранения Дампа изображения. Что это такое? 

Дамп изображения представляет собой набор файлов, содержащих информацих об изображении: файл 
метаданных с расширением inf, квиклук изображения в формате jpg, шейп-файл в формате ESRI SHP, файл 
проекции в формате prj и квиклук карты с границами изображения в формате png. Указанные файлы 
создаются в отдельной папке  в директории, указываемой пользователем. 

 
Как перемещаться по записям, выбранным для занесния в каталог или редактирования? 

Вы можете воспользоваться кнопками Next Image и Prev. Image для перемещения по записям в форме 
добвления записей в каталог и кнопками  Next Record и Prev. Record для перемещения между записями в 
режиме редактирования. Также можно воспользоваться ползунком, расположенным над указанными 
кнопками. Число в рамке слева от ползунка показывает порядковый номер текущей записи в группе записей. 

Почему при редактировании каталога не происходит добавления квиклука и шейп файла? 

Если изначально при занесении записи в каталог сохранения квиклука и ESRI шейп-файла не происходило, то 
при установке данных флажков в процессе редактирования этой записи добавление квиклука и карты с 
нанесенными границами изображения также не происходит.  
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Что нужно сделать, чтобы работать с базами данных, расположенными на другом ПК? 

Вам необходимо выполнить настройку удаленного сервера. Для этого вызовите диалог настроек приложения 
(File-> Options), перейдите в закладку Catalog и нажмите кнопку Add Server. В появившемся диалоге 
добавления сервера укажите параметры сервера и нажмите Add. После добавления новой записи в список 
доступных серверов, выделите ее и нажмите кнопку Set Default. После этого в панели Catalog будут 
отображаться базы данных установленного сервера. 

Как передать пользователям данные каталога, созданного мной? 

Существует несколько способов передачи данных каталога пользователям. Вы можете создать Дампы 
изображений интересуемого каталога и переслать их пользователям. Кроме того Вы можете воспользоваться 
опцией Export Catalog, указав имя каталога и директорию его сохранения. Полученные данные можно также 
пересылать пользователям, которым, в свою очередь, следует воспользоваться опцией Import Catalog для 
импорта каталога в свое приложение. 

 

Вопросы по работе с привязкой изображения и опорными точками 

 

Как можно узнать, имеет снимок  географическую привязку или нет? 

Существует несколько способов определения привязан ли снимок географически. Если иконка окна 
изображения имеет вид страницы с глобусом, то изображение географически привязано, если иконка имеет 
вид пустой страницы, то изображение географически не привязано. Кроме того, информацию о привязке 
открытого изображения можно получить в закладке Geo. Если переключатель установлен в положение Simple 
Image, то открытое изображение не содержит привязки. Если переключатель установлен в положение 
Geolocated Image то изображение содержит географическую привязку. Также наличие географической 
привязки можно проверить перемещая курсор мыши по полю изображения: если снимок геопривязан, то в 
закладке Info в темпе перемещения курсора будут выводиться географические координаты. 

Каким образом можно выполнить коррекцию географической привязки изображения? 

Коррекцию географической привзяки можно выполнить с помощью закладки Geo, элементы которой 
позволяют пересчитать параметры используемой математической модели привязки, для этого вам нужно 
наложить векторную карту на снимок и меняя параметры контролировать качество привязки. Для данных 
ДЗЗ, привязка которых выполняется по математическим моделям, описывающим движение и ориентацию 
спутника на орбите, предусмотрен удобный инструментарий Geo Pan. Этот инструмент позволяет подтягивать 
карту к снимку, после чего происходит расчет поправок параметров модели геопривязки. 

Как я могу узнать по изображению какая часть земного шара на нем отображена? 

Если снимок геопривязан, то это можно определить следующими способами. Вы можете открыть панель 
Manager и окно Region с нанесенными векторными картами административных границ государств и береговых 
линий и открыть папку с интересуемым изображением. При этом все геопривязанные изображения 



ScanMagic ® Documents How To Page 8 of 9  

F.A.Q. 

 

 

 

The information in this document is subject to change without notice. Last Updated: 9/17/2008 

Copyright © RDC ScanEx. All Rights Reserved.  www.scanex.ru 

отобразятся в окне Region в виде контуров покрытия. Если выделить в списке интересуемое изображение, то 
оно будет подсвечено красным цветом в окне Region, и Вы сразу определите, на какой территории 
расположен снимок. Вы можете открыть интересуемое изображение и в панели Info определить 
географические координаты снимка. Или воспользоваться закладкой World Map панели Navigator. 

Почему при экспорте изображения в один из форматов теряется его геопривязка? 

Если снимок картографически привязан, то привязка изображения может теряться в случае сохранения 
снимка в формат не предназначенный для хранения параметров картографической проекции.  Для 
сохранения привязки изображения нужно выбирать форматы, позволяющие это делать, например GeoTIFF. 

Как можно выполнить пересчет координат из одной проекции в другую? 

Вам необходимо воспользоваться Coordinates Converter, диалог которого можно вызвать через меню Tools -> 
Coordinates Converter. В диалоговом окне следует задать параметры исходной и выходной проекций и 
подгрузить или занести вручную значения координат. Для выполнения пересчета нужно нажать кнопку 
Convert, после чего пересчитанные значения координат отобразятся в списке выходных координат. 

Как выполнить привязку «изображение к изображению»? 

Нужно открыть изображение которое требуется привязать и эталонное изображение. Далее следует 
осуществить съем опорных точек с помощью элементов на панели GCP и обновить геопривязку (Image-
>Refresh Geolocation). Теперь вы можете трансформировать исходное изображение в нужную 
картографическую проекцию, и его привязка скорректируется с учетом заданных опорных точек. 

Как выполнить привязку по технологии «изображение к карте»? 

Существует два способа. Можно открыть исходное изображение и любое геопривязанное изображение с 
наложенной на него картой. Произвести съем опорных точек с помощью панели GCP. Далее при 
трансформировании изображения в нужную картографическую проекцию его геопривязка скорректируется с 
учетом этих ОТМ. Другим способом это можно сделать, поместив исходное изображение в Регион и туда же 
наложив векторную карту. В этом случае съем ОТМ производится в одном окне Региона. В этом случае после 
съема ОТМ следует нажать кнопку Refresh Geolocation. 

Как можно создать список опорных точек не имея векторных карт и других изображений? 

Можно воспользоваться глобальными мозаичными покрытиями Global Maps. Нужно открыть изображение и 
окно Global Maps  на интересующую территорию. Затем с помощью панели GCP выполнить съем опорных 
точек с изображения в окне Global Maps, работая с ним, как с обычным геопривязанным изображением. 

 

 

 



ScanMagic ® Documents How To Page 9 of 9  

F.A.Q. 

 

 

 

The information in this document is subject to change without notice. Last Updated: 9/17/2008 

Copyright © RDC ScanEx. All Rights Reserved.  www.scanex.ru 

Вопросы по работе с картографическими сервисами 

 

Для чего могут понадобиться картографические сервисы? 

Картографические сервисы, предоставляющие доступ к многотеррабайтным глобальным покрытиям, могут 
применяться в качестве источника опорной картографической основы, например, в случае отсутствия 
векторных карт на заданную территорию. Кроме того, в приложении реализован легкий способ перехода 
между различными картографическими сервисами. Данные сервисы объединены в одном окне, в котором с 
ними можно работать как с обычным большим изображением. 

Что нужно сделать, чтобы в окне Global Maps отображалась интересуемая меня территория? 

Нужно открыть окно Global Maps нажатием одноименной кнопки на панели инструментов, после чего открыть 
диалог Navigate в панели Global. В открывшемся диалоге следует указать координаты интересуемой 
территории и нажать кнопку Go. Для незначительных перемещений изображения в окне Global Maps можно 
воспользоваться группой кнопок Pan (Left, Right, Up, Down). 
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